STATE BUDGET PLANNING SYSTEM (SBPS)

FOR THE GOVERNMENT OF AFGHANISTAN

V.3.2

User Guide
TABLE OF CONTENTS

1. INTRODUCTION ................................................................................................................................. 4

2. OVERVIEW ............................................................................................................................................. 5
   2.1 BACKGROUND INFORMATION ................................................................................................. 5
   2.2 BUDGET PREPARATION WORKFLOW ...................................................................................... 6
   2.3 INTEGRATION WITH THE DAD ................................................................................................. 8

3. GETTING STARTED ............................................................................................................................... 9
   3.1 LOGGING TO THE SBPS ......................................................................................................... 9
   3.2 MAIN SCREEN .......................................................................................................................... 9
   3.3 TOOLBAR ................................................................................................................................. 10
   3.4 WORKSPACE OVERVIEW ....................................................................................................... 11

4. BUDGET PREPARATION & EXECUTION ............................................................................................... 15
   4.1 BUDGET CALENDAR ............................................................................................................... 15
   4.2 BUDGETING MODULE STRUCTURE ......................................................................................... 15
   4.3 BUDGET FORECASTING AND SENSITIVITY ANALYSES ....................................................... 16

5. WORKSPACE ORGANISATION ............................................................................................................. 17
   5.1 SPREADSHEETS ....................................................................................................................... 17
   5.2 WORKING WITH WORKSHEETS ............................................................................................ 17
   5.3 FILTERING OPTIONS ................................................................................................................. 19
   5.4 FAVORITES’ ORGANIZATION .................................................................................................... 23
   5.5 YEAR MANAGEMENT ............................................................................................................... 25
   5.6 USER MESSAGES ....................................................................................................................... 27
   5.7 CALENDAR ............................................................................................................................... 27
   5.8 REVENUE .................................................................................................................................... 29
   5.9 INCREASE .................................................................................................................................. 30
   5.10 ANALYSIS & REPORTING ......................................................................................................... 35
   5.11 DAD AFGHANISTAN ............................................................................................................... 35
   5.12 MY PROFILE MENU ............................................................................................................... 35
   5.13 CHANGE PASSWORD ............................................................................................................... 35
   5.14 PERSONAL INFO ..................................................................................................................... 36
# TABLE OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The SBPS Login Screen</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>The SBPS Main Screen</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>Toolbar</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>Main Workspace</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>Context Menu</td>
<td>12</td>
</tr>
<tr>
<td>6</td>
<td>Worksheet Changes Window</td>
<td>13</td>
</tr>
<tr>
<td>7</td>
<td>Cell History Window</td>
<td>13</td>
</tr>
<tr>
<td>8</td>
<td>Calendar Info</td>
<td>15</td>
</tr>
<tr>
<td>9</td>
<td>Worksheet Menu</td>
<td>18</td>
</tr>
<tr>
<td>10</td>
<td>New Worksheet Creation</td>
<td>18</td>
</tr>
<tr>
<td>11</td>
<td>View Menu</td>
<td>19</td>
</tr>
<tr>
<td>12</td>
<td>Filter Management Window</td>
<td>21</td>
</tr>
<tr>
<td>13</td>
<td>Applying Filters</td>
<td>21</td>
</tr>
<tr>
<td>14</td>
<td>Selecting Options</td>
<td>22</td>
</tr>
<tr>
<td>15</td>
<td>Favorites Menu</td>
<td>23</td>
</tr>
<tr>
<td>16</td>
<td>Add To Favorites Window</td>
<td>23</td>
</tr>
<tr>
<td>17</td>
<td>Favorites List</td>
<td>23</td>
</tr>
<tr>
<td>18</td>
<td>Go To Window</td>
<td>24</td>
</tr>
<tr>
<td>19</td>
<td>Manage Favorites Window</td>
<td>24</td>
</tr>
<tr>
<td>20</td>
<td>Tools menu</td>
<td>25</td>
</tr>
<tr>
<td>21</td>
<td>Year Management Window</td>
<td>26</td>
</tr>
<tr>
<td>22</td>
<td>User Messages Window</td>
<td>27</td>
</tr>
<tr>
<td>23</td>
<td>Calendar Window</td>
<td>28</td>
</tr>
<tr>
<td>24</td>
<td>Domestic revenue Year Selection</td>
<td>29</td>
</tr>
<tr>
<td>25</td>
<td>Domestic Revenue Window</td>
<td>30</td>
</tr>
<tr>
<td>26</td>
<td>Transfer type selection</td>
<td>31</td>
</tr>
<tr>
<td>27</td>
<td>Selecting Fund Transfer Source</td>
<td>32</td>
</tr>
<tr>
<td>28</td>
<td>Selecting Fund Transfer Source</td>
<td>32</td>
</tr>
<tr>
<td>29</td>
<td>Indicating Operational Budget Reserved Code</td>
<td>33</td>
</tr>
<tr>
<td>30</td>
<td>Describing Destination Project Elements</td>
<td>33</td>
</tr>
<tr>
<td>31</td>
<td>Calendar</td>
<td>34</td>
</tr>
<tr>
<td>32</td>
<td>Describing the Transaction</td>
<td>34</td>
</tr>
<tr>
<td>33</td>
<td>My Profile Menu</td>
<td>35</td>
</tr>
<tr>
<td>34</td>
<td>Changing Password</td>
<td>36</td>
</tr>
<tr>
<td>35</td>
<td>Personal Info Window</td>
<td>37</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The State Budget Planning System (SBPS) is a web-based budget management tool powered by Synergy IDM 5.5 (Intelligent Data Manager) integrated technology platform.

It is specifically designed to quickly and easily automate budget formulation and execution process and enables the following functionality:

- Draft and prepare budgets using the State Budget Planning System
- Prepare and review budgets in two directions: from top to bottom and from bottom to top
- Prepare and support multi-year budgeting
- Support multiple versions of central and local budgets
- Plan revenues and request expenditures
- Perform trend and sensitivity analysis
- Automatically populate the budgetary requests based on historical data

The State Budget Planning System (SBPS) has a web-based user-friendly graphical interface combining the best practices of MS Excel type spreadsheets with online electronic data entry forms. It also provides a variety of user interfaces based on the users’ roles in the budget planning and execution process.

The purpose of this document is to describe how the State Budget Planning System for the Government of Afghanistan application functions and to provide necessary instructions to ensure successful work with the application. The use of this document and the compliance with the standards specified herein is mandatory for anyone working with the mentioned application.
2. OVERVIEW

The State Budget Planning System (SBPS) is used by the Government of Afghanistan to automate the budget definition and preparation process and enhance monitoring of the approved budget’s execution.

The SBPS data is tightly integrated with the Development Assistance Database for Afghanistan (DAD Afghanistan) application. The DAD will serve as a main source of data on ongoing and planned development projects. From the SBPS point of view, donor commitments directed through the State Budget will be considered as revenue sources, while, at the same time, the implementation costs of the projects planned for upcoming years will form the budget requests.

The State Budget Planning System (SBPS) is integrated with the AFMIS treasury system used by the Treasury department of the Ministry of Finance of Afghanistan. Once the budget is approved by the Cabinet and the Parliament, the data should be exported to the AFMIS for budget execution, meanwhile the actual expenditure and revenue data should be imported into the SBPS to allow generating midterm review reports.

2.1 Background information

The Budget preparation cycle is comprised of two main phases: a) preparation of Preliminary Draft Budget or MTBF (by the end of September) and b) preparation of detailed National Budget.

Medium Term Budget Framework (MTBF) has been introduced formally for both the operating and development budgets. This framework allows the Government to plan its expenditures in the medium term and link its financial resources with the benchmarks it needs to achieve under the Afghanistan National Development Strategy (ANDS) and MDGs and other strategic priorities of the country.

The aim of preparing the MTBF is to estimate available financial resources in the following two years (both from domestic revenue and donor funds), to select most important priorities, based on the Afghanistan National Development Strategy (ANDS), that can be financed from the available funds and establish budget ceilings. The Ministry of Finance (MoF) is responsible for gathering required information from line ministries. To provide this information, ministries need to do priorities’ cost estimation.

Based on the information from MTBF, the MoF requests the ministries to prepare detailed budget calculations for selected priorities and within given ceilings. The MoF is issuing two separate circulars – Traditional Circular asking for operating budget and development projects, and Program Budget Circular, asking for budget breakdown by programs and sub-programs. This second circular supports program-based approach to budgeting.

The SBPS will support Program (Integrated) Budget Preparation on the level of line ministries, as well as automate its submission process to the Government.

The SBPS allows recording two main components of the state budget- recurrent (operational) budget and development budget, integrating them into a single data space and provides the Ministry of
Finance and the Government of Afghanistan with a final consolidated budget. The SBPS also provides the facilities to estimate the upcoming revenues. By capturing both revenues and expenditures the SBPS supports the budget negotiation process between the Ministry of Finance and all budgetary units. The budget negotiation process can include several rounds which may result in multiple iterations of the SBPS system.

The role of the SBPS is going beyond the point of budget finalization and approval by the Parliament. The finalized budget version should be exported to the AFMIS system for further budget execution. Furthermore, to provide the comprehensive analysis of the budget execution and monitoring processes, such as midterm reviews, the actual expenditures should be exported from AFMIS and imported back into the SBPS.

### 2.2 Budget Preparation Workflow

One of the key elements contributing to the successful implementation of an annual budget is the well-established budget formulation process.

At the beginning of each budget preparation cycle a new version of the budget is created and the year for budget planning is set to the next financial year.

The estimated revenues expected from taxes, customs and other income sources are entered into the SBPS by relevant agencies. The expected donor commitments, which are considered as another source of core budget, are imported from DAD Afghanistan. Alternatively, the SBPS has integrated forecasting mechanisms to project revenues based on historical data.

As soon as the planned revenues are entered into the SBPS module, the Ministry of Finance uses them for defining budget allotments. The allotments are set for every budgetary unit for each account of the chart of accounts.

As soon as the allotments are set, the SBPS will automatically generate official invitations and send them to all budgetary units.

The line ministries and other budgetary units prepare the budgetary requests for both operational and development components. The budgetary requests for the recurrent budget are entered through a set of eForms allowing for a breakdown of expenditures by categories. For the development component, priority is given to the ongoing activities/projects, while some funds might be reserved for new initiatives. The ministries work on their individual local copies of the draft central budget version. These copies are stored in the central database, but only registered users from relevant ministries have access to them. On the other hand, the users are able to modify/provide budgetary requests only to the budget lines (accounts, programs, etc.) which are related to their budgetary unit. As a result, no line ministry is able to modify another’s data. The budgetary allotments, set by MoF, are used as control figures to indicate any discrepancy between allowances and budgetary requests. These figures are available to the line ministries only in a read-only mode for control purposes. The SBPS allows users to link all entered budgetary requests to priority goals, ANDS, NPPs and laws and regulations, as well as input-related budget narratives to justify requested expenses.
As soon as the budgetary unit finalizes the process of formulating budgetary requests and all relevant eForms and SBPS screens are filled in, the authorized person shall submit this local draft budget into the central budget version. On submission the data from the local version will be imported into the Budgeting module aggregating the budgetary requests and providing the Ministry of Finance with total figures. Notification will then be sent to the Ministry of Finance, which will be able then to review and evaluate the requests.

Whenever the budgetary requests exceed the allotments specified, the Ministry of Finance organizes additional consultations for each line ministry on their requested budget in order to bring budget allowances in balance with budget requests. Based on the results of the negotiations, the Ministry of Finance appears in a position either to increase allotments, by reallocating available funds by budgetary categories and charts of accounts, or to reduce the planned expenditures by re-prioritizing them. After review and corresponding modifications, the budgetary unit once again gets access to its data in order to synchronize the requests with the budgetary allotments. This process may require several iterations/consultations.

Only when all the revenues and expenses are in balance, the budget negotiations are finalized and the budget is provided for the Parliamentary hearings. Still, some re-prioritization and re-arrangements are possible after the hearings. In this case, the above-mentioned procedure should be repeated.

As soon as the budget is approved by the Parliament, the last draft budget version will be converted into the final budget version and the data from SBPS will be exported into AFMIS for further budget execution.

During the budget planning and budget negotiation processes, the SBPS allows the government to create any given number of draft budget versions to keep track of the history of the budget definition process. To prevent starting budget definition from scratch for upcoming years, the SBPS populates original data for the first draft budget version based on historical patterns. The first draft is used for initiating the budget planning process for the given year. This initial data might be populated based on historical data using some simple trend analysis or applying some mathematical expressions. For example, budgetary requests might be defined by assuming the same pattern of expenditures for the last 5 years or by a simple increase of last year’s expenditures by 10%. Otherwise, if the Government of Afghanistan implements multi-year budgeting, data for the upcoming fiscal year will be copied from the approved budget version of the current year.

To conduct midterm review, it is necessary to import actual expenditures from AFMIS back into the central budgeting database. Then, the actual expenditure figures will be compared with the estimated ones. In case of discrepancy (budget deficit or positive saldo) a new version of the budget will be created and requested funds/requests reallocation will be done. Still negotiations and further input might be required from line ministries and other budgetary units. All modifications should be done and authorized in the same manner as original budget definition / planning. After final approval, the modified budget figures will be imported into AFMIS.
2.3 Integration with the DAD

While the intelligent spreadsheet of the SBPS is used for capturing the budget ceilings and calculation of aggregates for consolidated budget requests, the actual justification of the requested expenditures for development and recurrent budgets is captured through the DAD and eForms.

The intelligent spreadsheet allows drilling down to the level of the single project. Clicking on the cell automatically invokes the online data entry module and opens the project profile sheet for editing.

While the complete data is available for review, only the data relevant for the budget planning are available for editing. E.g. only the estimated expenditure requests for the current and upcoming fiscal years may be edited. This data is used for populating budgetary requests in the main spreadsheet.

For the requests made by line ministries, the DAD opens a new data entry form to capture basic project information. These requests are available only through the SBPS spreadsheet only, e.g. they will not appear in the list of approved projects in the main DAD interface.

The DAD also provides basic facilities to support request prioritization and approval. Once the request is approved as a part of budget, it will be automatically converted into a standard DAD project and will become available for further monitoring and analysis.
3. GETTING STARTED

3.1 Logging to the SBPS

The SBPS provides a centralized access point to all its modules and subsystems. The IDM Security Subsystem manages user’s access rights, tracks and audits user’s access to the system.

The SBPS uses a role-based security model, where the user rights and available functions depend on the role performed by the user in the budget formulation process. For example, users from the budgetary units gain access only to local level budget formulated for their unit, while the users at the Ministry of Finance have full access to the entire central level budget.

To login to the system, you should provide valid username and password and press the Login button (Figure 1). Please note that the password is case sensitive.

![Figure 1: The SBPS Login Screen](image)

**Note:**

After 30 minutes of inactivity, your session is terminated and you are disconnected from the SBPS.

3.2 Main Screen

The Figure 2 below represents the main screen of the SBPS and its components that you will see when accessing the software.

The SBPS working screen consists of two main parts: the Toolbar (a) on the top of the screen, and the Working Area (b) under it.

**Note:**

Your screen may look different to the screenshot below. In order to see the required data for reviewing, add a year by selecting Options from the View menu. For more information, please refer to the sections below.
3.3 Toolbar

The toolbar is placed above the working area and holds the main options that the SBPS provides to work on the budget preparation (Figure 3).

- Menus on the left side of the toolbar are designed to organize user workspace.
- Executing calendar information is placed in the middle of the toolbar.
- The SBPS has been implemented as a multilingual system. For the user's convenience the system has been designed to be used in two languages: English and Dari. To switch the language select the desired language option from the toolbar.
- To download the SBPS User Guide, click the Help button.
- Logged in as: section shows currently logged in user’s first and last names.
• To logout from the application press the **Logout** button on the right side of the toolbar. This will protect your information from other users’ access and will disable them from making modifications on the budget data.

### 3.4 Workspace Overview

The SBPS provides with a workspace for working on budget preparation (Figure 4). The workspace consists of MS Excel-like spreadsheets.

![Figure 4: Main Workspace](image_url)

1. Screen category titles
2. Row captions
3. Column captions
4. Year headers
5. Cell
6. Main sheet
7. Totals by rows
8. Totals by columns
9. Totals by row and totals by column
10. Control numbers
11. Totals by control numbers
12. Super control
13. Context menu opener button
14. Screen header
15. Back button
16. Refresh button
17. Worksheet tab
18. Worksheet delete button

The **Back** button (15) directs you back to that screen form which you have entered the current screen. This button has a drop-down menu which contains all drill-downed screens. By clicking on titles in the drop-down menu, you can navigate to the following screen (in the same state as it was previously left).

On clicking the **Refresh** button (16) you can remove all cashed history of data and update all data.

The user-specific worksheets contain combined data from main database and their own changes. You may keep multiple copies of the sheet with different variations of values. This tab bar (17) will help you to navigate within these Worksheets.

With worksheet delete button (18) you can delete a selected worksheet.

**Attention:**

Once the worksheet is deleted, it cannot be recovered anymore.

The provided cell value can either be aggregated or calculative. The added value is entered in Edit Dialog. Edit dialog appears when clicking the Edit button from Context menu (Figure 5). The aggregated value sums up the value for this cell from lower level screen cells sums. The calculative value is the value that was calculated by eForms.

![Figure 5: Context Menu](image)

19. Cell edit dialog open button
20. Cell value copy button
21. Cell value paste button
22. Unseal cell value button
23. Start transfer button
24. Do transfer button
25. Worksheet changes

Synergy International Systems, Inc.
26. Cell history
27. eForm
28. Open sub menu button
29. Sub menu
30. eForm (Operational Expenses)
31. Details

**Worksheet Changes (25)**

By selecting the Worksheet Changes option from the Context menu (Figure 5) the following window will appear (Figure 6). The worksheet changes show full editing history (with editing value, date and comment) for this cell in current work session.

![Figure 6: Worksheet Changes Window](image)

**a.** The worksheet changes window  
**b.** Dialog title  
**c.** Main table that show full editing history for this cell in the current work session  
**d.** A record  
**e.** The window close button

**Cell History (26)**

By selecting the Cell History option from the Context menu (Figure 5), the following screen will appear (Figure 7).

![Figure 7: Cell History Window](image)
a. Cell history window  
b. Cell history window title  
c. The records table  
d. A record details row  
e. Cell history window close button  

The Cell history window shows the cell value commitments history in main database (with Value, date, User name and comment) for this cell in current main database version.

eForms (27)  

The data entry forms can be accessed from the SBPS on the expenditure category level through the pop-up menu associated with the particular cell of the spreadsheet. eForms are web-forms that are logically connected to cells mainly on Project Screen level. By selecting the eForms option the respective eForm will be loaded where the required information should be filled in.
4. BUDGET PREPARATION & EXECUTION

4.1 Budget Calendar

The SBPS has a built-in budget calendar. The budget calendar is a list of activities performed during the budget preparation cycle. Each activity should have a start and end date. The budget department defines events in a budget calendar by specifying date, caption and notification text. The system displays the current event with highlighting the deadline in a separate pop-up window. This is done to provide with information on budget preparation and submission deadlines. To get this information point the mouse’s cursor to the Calendar name on the main Toolbar - a small Calendar Info window will appear (Figure 8).

You may benefit from the coloring scheme of the bulb icon representing the calendar which is used for notifications on submissions deadline status:

- Green - there is still enough time for budget submission.
- Yellow – calendar is in left state, i.e. the submission deadline is close.
- Red – the submission date has passed.

Please note that some cells and data layer might be frozen for particular user groups at the end of submission.

All budgetary units should submit their budgets proposal signed by the highest authority within their organization. Submissions must be put forward to the relevant MoF focal point. The Budget Committee decides on the budgets that were not submitted on time based on the ministry/organization’s previous year’s budget and absorption capacity. Late budget submissions are not acceptable.

4.2 Budgeting Module Structure

The SBPS provides an Intelligent Spreadsheet for viewing, modifying and zero-based planning of financial resources. It fully utilizes a concept of multilevel budgeting. The Budget Department Flow has a hierarchic nature (Ministry/ Program/ Sub-Program/ Activity/ Location/ Project) and a double click on every level of the hierarchy leads to the next one. At any level you can perform an exercise of bringing budget requests and allowances into balance. The Intelligent Spreadsheet helps formulate budget requests for several upcoming years at the same time. In addition, it may display the approved budget figures for current and previous years. When starting budget formulation for a new year, the budget figures from one of the previous years may be set as a basis (e.g. it can be imported from current year’s approved budget). It also would be possible to execute year-end carry forward procedure at the end of each financial year.
The spreadsheets in the SBPS are organized in a multi-level structure which can be useful in drilling down into the budgetary data, starting from the level of consolidated expenditure requests of all budgetary units to the level of detailed recurrent and development raw data.

### 4.3 Budget Forecasting and Sensitivity Analyses

The SBPS performs both trend- and driver-based forecast analysis. Both analyses require definition of budget drivers such as inflation and currency exchange rates. The drivers or the variables are separately defined in the corresponding sub-module. The drivers are used in the formulas calculating the projected expenditure requests or revenues for budget lines in the source data entry forms. By setting different values or defining trends for the given driver it would be possible to produce different budget scenarios. For example, by applying different values for currency exchange rate and inflation rate it would be possible to generate different versions of budgets based either on the current prices or including price adjustments.

The trend analysis can identify trends based on budget data from previous years, both actual and planned, and apply them to forecast the expenditure estimate for the upcoming years. It is obvious that in order to use trend analysis the budget database should contain information for at least two previous financial years. “What-If” analysis would allow tracking implications on the overall budget of the given single or multiple changes in the budget requests or incomes.

The SBPS provides a set of standard forecast methods for projecting revenues and expenditures. Based on the nature of the method, this may require the availability of the historical budget data collected/imported from previous financial year(s). Regression and simplistic forecast methods are currently implemented in the SBPS. Additional methods, such as deterministic, microeconomic and micro simulation methods might be implemented on demand.

Synergy Budgeting can perform sensitivity analysis by identifying and highlighting the dependencies between budget drivers and resultant budgetary requests. Identified dependencies can be used to create separate versions of the budget corresponding to the different values of drivers and resultant expenditure requests.

Please refer to the sections below for more information on how to set the drivers for analyses.
5. WORKSPACE ORGANISATION

5.1 Spreadsheets
The SBPS allows for entering budgeting information through spreadsheets. These spreadsheets have the same structure, consisting of rows and columns. These rows and columns represent two budgetary categories.

The columns represent major economic categories, such as salaries (code 21), goods and services (code 22), acquisition of assets (code 25), etc. You should select the years to display the data for. Each year will be displayed in a separate column. Please note that only five years details can be viewed simultaneously.

The rows represent budgeting flow hierarchy based on the user roles in the budgeting formulation (Program/ Sub-Program/ Activity/ Location/ Project). Double-click on every level will lead to the next level of the hierarchy.

At any level you can perform budget requests and allowances balance. In the case of unbalanced expenditures, i.e. when the aggregates exceed the allotments specified for the higher level, the total figure on the spreadsheet will be colored in red as well as the corresponding cell in the level above.

Every user has user-specific working screen flow. The SBPS provides an end-user interface with the functions and options according to the user role and stage of budget formulation/execution process. Other functions are either disabled or hidden.

5.2 Working with Worksheets
The SBPS provides a possibility for Worksheet creation/deletion and submission.

- To create a new worksheet, select the New option from the Worksheet menu (Figure 9).
  1. Provide a name for the worksheet and description in the appropriate fields of the New Worksheet window (Figure 10).

**Note:**
Fields marked with an asterisk (*) are required for filling.

  2. Specify the worksheet type (Planning or Executing) by selecting the appropriate radio-button.
  3. To create a copy of the existing worksheet:
     - Check the check-box. This will activate the list of existing worksheets.
     - Select the worksheet to be copied.
  4. Press Save to confirm OR Cancel to discard the operation.
   The newly-created worksheet will appear in the working area (Figure 2).
• To switch from one worksheet to another please use the tabs at the bottom of the working area (Figure 2).

• To delete a worksheet press the X button on the selected worksheet tab (Figure 4 -18).

![Worksheet Menu](image1)

**Figure 9: Worksheet Menu**

![New Worksheet Creation](image2)

**Figure 10: New Worksheet Creation**

The budget data modifications made locally in the worksheet of the SBPS application are not accessible to the other users unless you submit them to the server. This can be done on every stage of budget formulation process. To submit the modifications select the **Submit** option from the **Worksheet** menu (Figure 9).

To ensure the effectiveness and relevance of the worksheet data and thus give the different stakeholder involved the possibility to leverage information assets, SBPS is equipped with complex data submission control mechanisms. They verify the data to be committed and make sure that the latest data are not overwritten by the out-dated ones. Thus, if the **Submit** option is selected, one of the following three messages appear depending on whether there have been any modifications made or not:

1. In case no data have been changed, the “No data have been changed since the last commit” message will appear on the screen.

2. If you have made some modifications and there are no other changes committed by other users, then you will see the “Worksheet submitted successfully” message.
3. In case some changes are made in the worksheet data and there are other modifications available on the server, the following message appears: “There are some updates available. Please load them before submitting the data.”

SBPS allows you to download the latest modifications available on the server. This way, you can check out and work with the most recent data thus excluding the possibility of misinterpretation or inaccurate analysis.

In order to download the latest changes select the Update option from the Worksheet menu (Figure 9). Depending on the availability of the modifications on the server, one of the following messages may occur:

1. “No updates are available at this time.” – This message will appear if there are no changes to update.

2. “Worksheet updated successfully.” – This message will appear if there is no inconsistency or conflicts between modifications on the server and modifications in the user’s worksheet.

3. If there are conflicts between the modifications on the server and the modifications in the worksheet, you should choose between the following three options:
   - Keep the values in the worksheet. This will overwrite the data on the server with the appropriate data from the worksheet.
   - Keep server values. This will load data from the server.
   - Resolve conflicts manually. If this option is selected, you should define whether you wish to keep values in your worksheet or load the data from the server for each conflicted data.

In some cases, changes can be submitted to the server while you update the data. In this case, the update operation is cancelled and the appropriate notification appears.

5.3 Filtering Options

The SBPS application is used to organize the working area in a convenient way. To choose the required information to be displayed, select the Filters option from the View menu (Figure 11).

In the Filter Management window (Figure 12) indicate rows and columns to be displayed by selecting the appropriate instance from the Available panel. Please note that it is possible to select several available instances. Click the (Select) button. The selected instances will appear in the Selected panel.
In order to re-order the selected instances, select the instance that needs to be removed from the *Selected* panel. Click the \( \text{(Unselect)} \) button. The selected instance will be removed from the *Selected panel.*

**Note:**

You can move all options from *Available* to the *Selected* part and vice-verse at once by means of \( \text{ahkan} \) and \( \text{ahkan} \) buttons.

Vertical buttons \( \text{ahkan} \) allow reordering items in the selected panel. You have to select an item to move and press the appropriate button. Arrows will move the selected item above or below one by one; double arrows will move the selected item at the beginning or the end of the list.

Press **Save** to confirm OR **Cancel** to discard the operation.
After filtering, the selected items will appear in the working area in the order specified. The small button will notify in case the filter is applied on the page (Figure 13). To unfreeze, press the Reset Filters button.

Other available variants for working space organization can be accessed by selecting the Options option from the View menu (Figure 11). The Options window will appear (Figure 14):

- Add Option: You may configure your own options by adding new ones. To add a new option, specify a name and press the green plus sign on the right. The option name must be unique.

- Memorized Options: This field shows all the previously saved options. You may select one of these options from the drop-down list if you wish to work on one of the saved options.
- Years: This field consists of two list boxes (Available and Selected). The Available list box shows closed, submitted, frozen and user-created fake years. The selected list box shows the years selected from the Available list box. Selected years will appear in the main screen.

- Rounding: Select numbers rounding (form thousands to quintillion).

- Grouping: Specify the grouping.

- After Edit Cursor Movement: This field information defines the way the mouse shall move after the Enter button is pressed (right (forward) or down).

Press **Save** to confirm OR **Cancel** to discard the modifications made.
5.4 Favorites’ organization

The SBPS provides quick access to the selected worksheets. To add the desired worksheet to the favorites list select *Add To Favorites* option from the *Favorites* menu (Figure 15).

![Favorites Menu](image)

Figure 15: Favorites Menu

The *Add To Favorites* window will appear (Figure 16).

![Add To Favorites window](image)

Figure 16: Add To Favorites window

- Provide a name of the worksheet in the *Name* field.

- To make fast navigation from the *Favorites* menu possible select *In shortcuts* checkbox (Figure 16). If the option *In shortcuts* is checked, then the name of worksheet appears in the submenu of the *Favorites* menu. You can access the desired worksheet by simply pressing on the name of the worksheet to display (Figure 17).

- By selecting Default option you can set the selected worksheet as the default sheet.

![Favorites List](image)

Figure 17: Favorites List
If shortcut has not been added, you can go to the desired favorite by selecting it from Go to… option from the Favorites menu (Figure 15). The following window will appear (Figure 18).

![Figure 18: Go to window](image)

Select the desired worksheet from the Favorites drop-down list. The values in the Screen and Info fields will be automatically generated.

It is possible to rename and/or delete a selected worksheet from the favorites’ list, add or remove it from the shortcuts and change the default favorite. To do so, select the Manage favorites option from the Favorites menu (Figure 15). The following window will appear (Figure 19). Make changes in the data displayed. Click Save to confirm, or Cancel to discard the changes made.

![Figure 19: Manage Favorites Window](image)
5.5 Year Management

The SBPS provides a number of tools to be used during work with worksheets. To edit the desired year, select the Years option from the Tools menu (Figure 20).

![Figure 20: Tools menu](image)

The Year Management window will appear (Figure 21):

- **Add Year**: In the Add Year field you can add a new fake year. You should provide a name for the year and press the green plus sign to the right of the field to add the year to the list.

- **Year**: The Years combo-box shows closed, submitted, frozen and user fake years. It also shows the selected year, the real year (if this name and the name in the combo-box are same, it means that the year is real), whether the current year is read-only or not, and the year comment. Provide the required information in the appropriate fields.

- **Specify drivers for the selected year**: By pressing the Edit button you can modify the added information for the driver, i.e. name, user value, description and real value.

**Note:**

If any driver’s value is changed all dependent cells data will be recalculated and rollup aggregation will be made for those cells.

- **Press Save** to confirm OR **Cancel** to discard the operation.
In the Year Management window (Figure 21) you can create fake years from the existing closed, calendar submitted and frozen years, and can also edit year drivers’ values and make recalculation for specified years.

The set of values per each driver may consist either of manually entered values or be automatically generated, based on some formula or a trend. In order to perform forecast analysis, the value for the driver should be provided on a yearly basis, while “what-if” analysis would require a set of different values entered for one financial year.
5.6 User Messages

This tool provides an opportunity to edit messages for different categories: Years, Options titles, WorkSheet titles, and Favorites titles. You can provide names of these categories in two languages: English and Dari.

To edit the message select User Messages option from the Tools menu (Figure 20). The User Messages window will appear (Figure 22):

1. Select the category from the drop-down list. The items of the selected category will appear.

2. To edit the selected item press the Edit icon to the left.

3. Edit the information provided.

4. Press the OK icon to confirm the information input, or the Cancel icon to discard the changes made.

![User Messages Window](image)

Figure 22: User Messages Window

5.7 Calendar

The system provides an opportunity for reviewing the SBPS Budget Calendar. To edit the desired calendar/process, select the Calendar option from the Tools menu (Figure 20). The calendar window will appear (Figure 23).

In the Calendar window you can see the current event name and the time left until the end of the event in the corresponding fields.

For more information on the current year’s budget preparation timetable please refer to the Budget Calendar information file. It can be downloaded by pressing the link at the top of the Calendar window.
The Calendar has several events. Each event has a start date and end date. The end date of the event must coincide with the start date of the next event.

Each event consists of one or two processes. The first process is general and refers to the Budget Department employees only. The second process refers to each ministry workflow (for Line-Ministry employees).

Depending on the event, the execution of the processes can be either sequential or parallel.

**Note:**
The file should be previously uploaded by the administrator; otherwise the link for download will not be displayed.

PDF Generation – If you see “None” in the list of available actions of the Actions drop-down list, it means that you do not have actions to perform (or there are no more actions to perform) according to your role in the budget preparation workflow.
If there are no more events specified in the calendar, the administrator must close this calendar and years from the SBPS Administration module (Budget Calendars tab).

**Note:**

**PDF Generation** – You can generate the state of budget calendar in the PDF format by pressing on PDF icon. The generated PDF contains the same information displayed in the Calendar window.

### 5.8 Revenue

The SBPS provides the facilities to estimate the upcoming revenues.

To add domestic revenue, select the *Revenue* option from the *Tools* menu (Figure 20).

Select the year for the revenue from the respective drop-down list (Figure 24). This will activate the currency and domestic revenue fields.

Provide the information requested (Figure 25), i.e. select the currency and specify the revenue estimated and actual amounts.

![Figure 24: Domestic revenue Year Selection](image)
5.9 Increase

It is possible to perform a money transfer from a project to another or from reserve fund to a project. To perform this operation, select the Increase option from the Tools menu (Figure 20).

**Note:**

This option is available only for execution worksheets.

The Increase/Decrease window will appear (Figure 26).

To perform the transfer you should select its type (either project or reserve fund), source categories and year from which the transfer will be performed, and destination categories.

If Project is selected as transfer type, the following window will appear (Figure 27). Select Ministry/Program/Subprogram/Activity/Location/Expenditure/Project/Year for the source project. Then press the Next button at the bottom of the window and provide the same data for the destination project.

**Note:**

The destination year is the same as the source year.
Check the cost elements for source and destination projects. Make changes if required.

**Note:**

In case of project type transfer the amount is defined by editing the eForm of source project and then this amount is added to the destination project eForm. The balance of these two amounts must be equal to 0.

Click the **Finish** button to save the transfer.

**Note:**

Fields marked with an asterisk (*) are required for filling. Press **Next** to move to the next view, **Back** to go back to the previous view, **Save** to save the transfer or **Cancel** to discard the operation.

In case of reserve fund transfer you must mention the amount of transfer explicitly and it must not exceed the current value of the reserve fund. Then edit the destination project eForm so that the grand total is increased by the transferred amount (the balance shown above the table must be equal to 0).

The tables below provide brief description of the fields that the funds transfer wizard consists of. Also, they provide instructions on how to enter the data required.

![Figure 26: Transfer type selection](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
<th>Is Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ministry</td>
<td>Select the ministry that serves as the originator of the transferred funds.</td>
<td>Yes</td>
</tr>
<tr>
<td>Expenditure</td>
<td>Indicate what the transferred amount will be spent on.</td>
<td>Yes</td>
</tr>
<tr>
<td>Year</td>
<td>Select the year when the transferred funds will be expended.</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Instructions</td>
<td>Is Required?</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Ministry</td>
<td>Select the ministry the funds will be transferred to.</td>
<td>Yes</td>
</tr>
<tr>
<td>Program</td>
<td>Select the program that will receive the funds.</td>
<td>Yes</td>
</tr>
<tr>
<td>Sub-Program</td>
<td>Indicate the sub-program within the selected program.</td>
<td>Yes</td>
</tr>
<tr>
<td>Activity</td>
<td>Specify the activity within the selected sub-program.</td>
<td>Yes</td>
</tr>
<tr>
<td>Location</td>
<td>Indicate the geographic location the program will extend in.</td>
<td>Yes</td>
</tr>
<tr>
<td>Expenditure</td>
<td>Specify what the funds will be used for.</td>
<td>Yes</td>
</tr>
<tr>
<td>Project</td>
<td>Select the project to support.</td>
<td>Yes</td>
</tr>
<tr>
<td>Year</td>
<td>This is the year indicated during source selection.</td>
<td>Read-only</td>
</tr>
</tbody>
</table>

Figure 27: Selecting Fund Transfer Source

Figure 28: Selecting Fund Transfer Source
### Field Instructions

<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
<th>Is Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Value</td>
<td>Indicates the current value of the operational budget.</td>
<td>Read-only</td>
</tr>
<tr>
<td>Transfer</td>
<td>Specify the amount to be transferred.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

#### Figure 29: Indicating Operational Budget Reserved Code

<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
<th>Is Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Element</td>
<td>Indicate the cost of the elements comprising the destination project.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>Provide any additional information that will further describe the destination project and its budget.</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Figure 30: Describing Destination Project Elements
<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
<th>Is Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction ID (T-Code)</td>
<td>Indicates the unique ID ascribed to the transaction.</td>
<td>Automatically generated</td>
</tr>
<tr>
<td>Transaction date</td>
<td>Indicate the date when the transaction takes place. A calendar pop-up is available for this purpose.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Note: Hijri calendar is available in the Dari form and Gregorian calendar - in the English form.</td>
<td></td>
</tr>
<tr>
<td>Transaction Description</td>
<td>Provide additional information about the transaction.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

![Figure 31: Calendar](image)

![Figure 32: Describing the Transaction](image)
5.10 Analysis & Reporting

As a comprehensive analytical and reporting tool, SBPS provides you with the variety of views of the data for better analysis and decision-making. The reporting component of the system includes ad hoc list, tabular, and chart reports. The analytical component includes guided decision-making and experiment design.

To access the Analysis & Reporting component, select the Analysis & Reporting option from the Tools menu (Figure 20). Selecting this menu item will transfer to you to an application outside SBPS. For more information on how to conduct data analysis and design reports, please refer to the corresponding sections of DAD Afghanistan User Manual.

5.11 DAD Afghanistan

As it has been stated in the paragraphs above, SBPS is closely integrated with the DAD Afghanistan application that serves as the main database of donor activities in the country. Moreover, SBPS provides direct access to the data recorded in DAD Afghanistan. In order to access the application from SBPS, you need to select the DAD Afghanistan option from the Tools menu (Figure 20). Selecting this menu item will transfer to you to an application outside SBPS. For more information on how to interact with the application, please refer to the DAD Afghanistan User Manual.

5.12 My Profile menu

My Profile menu provides for an opportunity to change your current password, as well as review and modify your personal information (Figure 33).

![Figure 33: My Profile Menu](image)

5.13 Change Password

To change the password, select the Change Password option from the My Profile menu (Figure 28). The Change Password window will appear (Figure 34).

To change password you should:

- Provide the valid password by filling Old Password field.
- Type a new password in the New Password field.

Note:
The new password must not repeat previous three passwords and must contain only allowed symbols.

- Retype the new password in the Confirm Password field to confirm it. This field must match New Password field information.

Please note that the password is case sensitive.

Press Save to save the information input or Cancel to discard the changes made.

![Figure 34: Changing Password](image)

**5.14 **Personal Info

To review and edit the personal information, select the Personal Info option from the My Profile menu (Figure 33).

The Personal Info window will appear (Figure 35). Make the necessary changes in the personal information.

**Note:**

Fields marked with an asterisk (*) are required for filling.

Press Save to confirm OR Cancel to discard the operation.
### Personal Info Window

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>admin</td>
</tr>
<tr>
<td>First Name</td>
<td>Admin</td>
</tr>
<tr>
<td>Last Name</td>
<td>Admin</td>
</tr>
<tr>
<td>Email Address</td>
<td></td>
</tr>
</tbody>
</table>

Figure 35: Personal Info Window